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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider Cox Communications and Avaya IP Office 9.0 with
Avaya Session Border Controller for Enterprise Release 6.2.1.

Cox Communications SIP Trunking provides PSTN access via a SIP trunk between Avaya
enterprise and Cox network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Cox Communications is a member of the Avaya DevConnect Service Provider program.
Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Cox Communications (here on referred as Cox) and an Avaya IP
Office solution. In the sample configuration, the Avaya IP Office solution consists of an Avaya IP
Office 500v2 Release 9.0, Avaya Micro Session Border Controller for Enterprise release 6.2.1
(Avaya SBCE), Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya H.323, digital, and
analog endpoints.

The Cox SIP Trunking service referenced within these Application Notes is designed for business
customers. The service enables local and long distance PSTN calling via standards-based SIP trunks
as an alternative to legacy analog or digital trunks, without the need for additional TDM enterprise
gateways and the associated maintenance costs.

The Cox SIP Trunking service uses Digest Authentication for outbound calls from the enterprise,
using challenge-response authentication for each call to the Cox network based on a configured user
name and password (provided by Cox and configured in IP Office). This call authentication scheme
as specified in SIP RFC 3261 provides security and integrity protection for SIP signaling.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Cox SIP Trunking service via Avaya SBCE. This configuration (shown in Figure 1) was
used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Cox SIP Trunking service via
Avaya SBCE. To verify SIP Trunking interoperability, the following features and functionality were
exercised during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various phone types. Phone types included H.323, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, digital, and
analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from the Avaya IP Office Softphone.

e Inbound and outbound long holding time call stability.
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Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

Codec G.711MU.

Caller number/ID presentation.

Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Use of SIP Re-INVITE and REFER for call transfer to PSTN.

Faxing using G.711 Pass Through.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

2.2. Test Results
Cox SIP Trunking passed compliance testing.

Items not supported or not tested included the following:

G.729 codec is not support.

T.38 Fax is not support.

Cox system does not support REFER for call transfer at the moment.
Cox does not use either PPI or PAI for the purposes of privacy.

Interoperability testing of Cox SIP Trunking was completed with successful results for all test cases
with the exception of the observations/limitations described below.

Call Display on PSTN Phone — Call display was not properly updated on PSTN phone
involved in a call transfer. After the call transfer was completed, the PSTN phone did not
display the actual connected party but instead showed the party that initiated the transfer.
SIP signaling trace showed that the enterprise IP Office did not send an UPDATE message
to the network to update the call display of the PSTN phone in call transfer. However, it
does not affect the end user.

Call Display on PSTN Phone on PSTN Hold and Resume — Call display was not properly
updated on PSTN phone involved in PSTN Hold and Resume operation. After the inbound
call from PSTN to Avaya IP Office was hold on PSTN phone, when the call was resumed on
the PSTN phone, the PSTN phone displayed trunk number instead of the calling party ID.

Call Redirection (Transfers) Using REFER method — Cox system does not properly
response to REFER request with 202 Accepted but with 403 Forbidden or 603 Decline
reason. The calls are being transferred successfully with 2 ways voice path.
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2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Cox SIP Trunking, contact Cox at http://www.cox.com.
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Cox SIP Trunking service through the public IP network. For confidentiality and
privacy purposes, actual public IP addresses used in this testing have been masked out and replaced
with fictitious IP addresses throughout the document.

Located at the enterprise site are Edgewater EdgeMarc 4550 series (EdgeMarc SIP in B2BUA mode,
referred to as EdgeMarc throughout this document), Avaya SBCE and Avaya IP Office 500v2 with
the MOD DGTL STA16 (Module Digital Station 16) expansion which provides connections for 16
digital stations to the PSTN, the extension PHONE 8 card which provides connections for 8 analog
stations to the PSTN as well as 64-channel VCM (Voice Compression Module) for supporting VVolP
codecs. The LAN port of Avaya IP Office is connected to the enterprise LAN while the WAN port
is connected to the Public IP network. The Avaya SBCE inside interface (enterprise side, Al) is
connecting to the enterprise LAN and its outside interface (B1) is connecting to the LAN port of the
EdgeMarc while WAN port of EdgeMarc is connected to public IP network. Endpoints include an
Avaya 9600 Series IP Telephone (with H.323 firmware), an Avaya 9508 Digital Telephones, an
Avaya Symphony 2000 Analog Telephone and an Avaya IP Office Softphone. A separate Windows
XP PC runs Avaya IP Office Manager to configure and administer the Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.

Cox Communications

SIP Trunking Services
20.164.94.12

1
sip/ |

uDP %l
EdgeMarc 4550 el il

192.168.1.1 & =

Avaya Session Border .
Controller for Enterprise Outside 192.168.1.200
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(Enterprise LAN Enterprise LAN Enterprlse LAN ()

Avaya IP Office I 10.10.97.39
= \
.
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Avaya IP Office Avaya 9600-Series A aya 11x0 SIP /\vay a Voicemail Pro
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Figure 1: Test Configuration for Avaya IP Office with Cox SIP Trunking Service
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Note: Cox system required that EdgeMarc to be resided on the same subnet of Avaya IP Office as
shown in the Figure 1. EdgeMarc is part of Cox SIP Trunking service offering.

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to Cox system. The short code of 9 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to Cox. For calls within the North American
Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP calls, Avaya
IP Office would send 11 digits in the Request URI and the To field of an outbound SIP INVITE
message. It was configured to send 10 digits in the From field. For inbound calls, Cox SIP Trunking
sent 10 digits in the Request URI and the To field of inbound SIP INVITE messages.

Cox uses the phone number in the From header of a SIP INVITE message to authenticate the calling
party. Thus, a call will be rejected by the network unless the From header contains a number known
to Cox. This is especially important for calls inbound from the PSTN which are redirected back to
the PSTN by call forwarding or twinning. For call forwarding, Avaya IP Office sends the number of
the forwarding phone in the From header. This is a number known to Cox. As a result, the call
display on the destination phone shows the forwarding party not the original caller. For twinning,
this behavior can be slightly altered through configuration. See Sections 5.3 and 5.4 for details.

Note that the calling party authentication using the phone number by Cox, as mentioned above, is in
addition to the Digest Authentication by Cox. During call setup, SIP signaling exchanges are using
user name and password as configured in Avaya IP Office for all calls from the enterprise to Cox.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Officer such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office 500v2 9.0.0.829
Avaya IP Office Manager 9.0.0.829
Avaya Voicemail Pro for IP Office 9.0.0.829
Avaya Session Border Controller for 6.2.1Q07
Enterprise (running on Portwell CAD-0208
platform)
Avaya 11x0 IP Telephone (SIP) SIP11x0e04.03.12.00
Avaya 9630G IP Telephone (H.323) Avaya one-X® Deskphone Edition S3.2
Avaya IP Office Softphone 3.2.3.20 64770
Avaya Digital Telephone (9508) N/A
Avaya Symphony 2000 Analog Telephone N/A

Cox SIP Trunking Service Components

Component Release
Edgewater EdgeMarc 4550 Version 11.6.14
ACME/Oracle 9200 nnSD710m3p4 and nnSD710m4p?2
Broadsoft AS, NS =R19
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5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to Cox SIP
Trunking service. Avaya IP Office is configured through the Avaya IP Office Manager PC
application.

From a PC running the Avaya IP Office Manager application, select Start - Programs - IP
Office = Manager to launch the application. Navigate to File = Open Configuration, select the
proper Avaya IP Office system from the pop-up window, and log in with the appropriate credentials.
A management window will appear similar to the one shown in the next section. The appearance of
the IP Office Manager can be customized using the View menu. In the screens presented in this
section, the View menu was configured to show the Navigation pane on the left side, the Group pane
in the center, and the Details pane on the right side. These panes will be referenced throughout the
Avaya IP Office configuration. Proper licensing as well as standard feature configurations that are
not directly related to the interface with the service provider (such as LAN interface to the enterprise
site and IP Office Softphone support) is assumed to be already in place.

5.1. LAN Settings

In the sample configuration, the DevCon IPO2 was used as the system name and the WAN port was
used to connect the Avaya IP Office to the public network. The LANL1 settings correspond to the
WAN port on the Avaya IP Office. To access the LAN settings, first navigate to System (1) =
DevCon IPO2 in the Navigation and Group Panes and then navigate to the LAN1-> LAN Settings
tab in the Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office
WAN port. Set the IP Mask field to the mask used on the public network. All other parameters
should be set according to customer requirements.

] Avaya IP Office R Manager DevCon IPO 2 [9.0.0.829] [Administrator(Administrator)]

File Edit Wew Tools Help
HEERv -2 %8
DevCon IPO 2 ¥ System v DevConIPO 2 'j
IP Offices Eij DevCon IPO 2° ek -8 X|v|<]|>
2R zoo"z (733) System | LANL | Lanz | DS | voicemail | Telephony | Directory Services | System Events | sMTP | SMDR | Twinning | vam ¢ »
¢/ Operator - : —1 1 1l I | |l Il Il l :
=-%% DevCon IPO 2 ILAN Settings |VoIP Network Topology
(=% System (1) [ -
&2y DevCon IPO 2 1P Address 10 10 97 39 |
@14 Line (9) IP Mask [255 | 255 . 255 | 240
[#-<=» Control Unit {4} 3
(# 4 Extension {42) Primary Trans. IP Address 0 0 0 0
#§ User(44) .
& # Group (7) RIP Mode \Mone 5
[+ 8% Short Code (67) [ Enable NAT
B service (0)
[# oy RAS (1) Number OF DHCP IP Addresses 2 =
@ Incoming Call Route (13) B
€2 wanPort (0)
o= Directory (0) O server O client O Dialin &) Disabled
£ Time Profile (0)
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Select the Vol P tab as shown in the following screen. The H323 Gatekeeper Enable box is checked
to allow the use of Avaya IP Telephones using the H.323 protocol, such the 9600-Series IP
Telephones used in the sample configuration. The SIP Trunks Enable box must be checked to
enable the configuration of SIP trunks to Cox. The SIP Registrar Enable box is checked to allow
Avaya IP Office Softphone usage. The RTP Port Number Range can be customized to a specific
range of receive ports for the RTP media. Based on this setting, Avaya IP Office would request RTP
media be sent to a UDP port in the configurable range for calls using LANL1. The specific values
used for the compliance test are shown in the example below. All other parameters should be set
according to customer requirements.

IP Offices

ﬁ

DevCon IPO 2°

| X|wl<l>}

- R BOOTP (72 ) System LAN27 DMS Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | YCM CCR Codecs
+ 47 Operator (3 = = 5
DevCon IPO 2 | LAN Settings I WYoIP |Netw0rk Topoloay )
= %=y System (1) I | A
% DevCon IO 2 H323 Gatekeeper Enable
WY Lne (9) [] Auto-create Extn Auto-create User [[] H323 Remote Extn Enable
[+ Control Unit {4)
[+ 4 Extension {(42)
wog User(44) SIP Trunks Enable
- 58 Group (7) )
-8 Short Code (67) SIP Registrar Enable
@D service (0) [[] Auto-create ExtnjUser [[] sIP Remote Extn Enable
- ol RAS (1) .
[+ Q Incoming Call Route (13) Domain Narne
£ wanPort (0) = = —
V| UDP UDP Port  |S060 |
@m Directory {0} M ] — £
N i : oy = —
£ Time Profile (0) Layer 4 Protocol Tcp TCP Port  |S060 =
- @ Firewall Profile (1) —— =
- ll 1P Route (2) dmus TLSPort [5061 2]
#m Account Code (0} e =
Challenge Expiry Time {secs |10
W License (41) e CER (secs) —
@& Tunnel {0)
- §i5 User Rights (8) RTP
- ARS (1) Port Mumber Range
5 Location (0) b I = : 2|
" [ 49152 M. 53246
2% Authorization Code (0) R - L s ‘ |
Port Mumber Range {NAT)
Minimurn 49152 $ Maximum 53296 3|
Enable RTCP Monitoring on Port 5005
Keepalives
Scope RTP | Periodic timeout |30
Initial keepalives 'VEnabled v
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 9 of 53
SPOC 03/26/2014 ©2014 Avaya Inc. All Rights Reserved. CoxSIPTIPO9SBC



On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider. See Section 5.9 for complete details.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port. Public Port is
set to 5060 for UDP.

e All other parameters should be set according to customer requirements.

Eij DevCon IPO 2° ek -8 X|v|<|>

System? LAN1 |l LamM2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR || Twinning | ¥CM | CCR | Codecs

LAN Settings | voIP | Metwork Topology

Metwork Topology Discovery

STUN Server Address 10.10.10.10 " STUNPort 3478 2|

Firewall/NAT Type |Open Internet v

Binding Refresh Time (seconds) 60 3 |

ic IP Address 10 10 97 39 Cancel
Public Port
LDP |S060 s
TCP o 3
s o =]

[[] Run STUN on startup

In the compliance test, the LAN2 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LAN2 interface configuration is not directly relevant to the interface with Cox
SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane. Choose the Companding Law
typical for the enterprise location. For North America, ULAW is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the
service provider across the SIP trunk. Set Hold Timeout (secs) to 600.

B DevCon IPO 2 =

System | LAN1 | LANZ || DNS Yoicemail | TE|eDh0nYl;Directory Services | System Events | SMTP fSMDR Twinning | YCM CCR Codecs |

| X | v | <|

Telephony | Park & Page | Tones & Music | Ring Tones | SM Call Log | TUI

~
Analogue Extensions Companding Law --
P ——— — Switch Line
Default Qutside Call Sequence | Mormal v 1
Default Inside Call Sequence iRing Type 1 v © U-Law @ U-Law Line
Default Ring Back Sequence ?ﬁing Type 2 v
3 = O A-Law O A-Law Line
Restrict Analogue Extension Ringer Yoltage |
Dial Delay Time {secs) 1{‘* s | [] pss status
Dial Delay Count 30 = Auto Hold
Default Mo Answer Time (secs) %15 2 Rl By Hame
Hold Timeout (secs) 600 5 show Sccpupt Code
Park Timeout (secs) 300 A~ I [[] 1nhibit OFf-Switch Forward] Transfer
rk Timeoul ; v |
— I:] Restrict Network Interconnect
Ring Delay (secs) 1‘5 < | 0
e — Drop External Only Impromptu Conference
Call Priority Promotion Time {(secs) iDisabIed = & AR
r ’4‘ [] visually Differentiate External Call
Default Currency |UsSD v
‘ — 7‘ [[] unsupervised Analog Trunk Disconnect Handling
Default Name Priority | Favor Trunk v
— = High Quality Conferencing
Media Connection Preservation | Disabled v
[] strict s1PS
Digital/Analogue Auto Create User
v
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5.3. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of

other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the System=>Twinning tab. The second parameter is the
Send Caller ID parameter on the SIP Line form (shown in Section 5.4).

For the compliance testing, the Send original calling party information for Mobile Twinning as
shown below was unchecked. This setting allows Send Caller ID parameter that was set to
Diversion Header in Section 5.4.2 to be used. IP Office will send the following in the “From”
header:
e On calls from an internal extension to a twinned phone, IP Office sends Calling Party
Number of the originating extension.
e On calls from the PSTN to a twinned phone, IP Office sends Calling Party Number of the
originating PSTN party.
Click OK to commit (not shown).

IP Offices DevCon IPO 2 & | X | v |<|>

# R BOOOTP (72 ) System | LAM1 | LANZ | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning |jv € »
+ {7 Operator (3 [ - - - z z
= %% DevCon IPO 2 ID Send original calling party information for Mobile Twinning I
=)=y System (1) Calling party information for |
%2y DevCon IPO 2 Mobile Twinning

5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Cox SIP Trunking
service. The recommended method for configuring a SIP Line is to use the template associated with
these Application Notes. The template is an .xml file that can be used by IP Office Manager to
create a SIP Line. Follow the steps in Section 5.4.2to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses.

SIP Credentials (if applicable).

SIP URI entries.

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.4.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.
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Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New - SIP Line. Then, follow the steps outlined in Sections 5.4.2.

5.4.1. Create SIP line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to CoxSIPTIPO9SBC.xml. The file name is important in locating the proper
template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK.

£ 1P Office Manager Preferences

Preferences | Directories | Discovery | Visual Preferences | Security | Walidation

Icon Size | Small A
Multiline Tabs
Enable Template Options

i) [ a4 H Cancel H Help ]

3. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

'] Avaya IP Office R9 Manager DevCon IPO 2 [9.0.0.829

File Edit View Tools I Help

Extension Renumber...

Line Renumber...
Connect To...

Export >

@ & BOOTP (7

SCN Service User Management
17 Operator (3)

o

“zy DevCon IPO 2 Busy on Held Yalidation

(=% System (1)
w2y DevCon MSM Configuration

=T+ Line {9)
el | Import Templates in Manager |
o 2

In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.
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4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New = New SIP Trunk From Template.

IP Offices

;- & BOOTP (7)

SIP Line -Line 19"

gTransport’;}SIP URI YoIP | T38 Fax|SIP Credentials

| SIP Line

4% Operator (3) ‘ } :
[=1-%% DevCon e "cn il
G-y Systq . New > H323 Line
SREe i (70 Ctri+X IP DECT Line
il |7 SIP Li
o 453 Copy Ctri+C ine
Ny 1 [F8 Pas ) SM Line
:‘ i 72<| Delete Chrl+Del | SIP DECT Line
\‘ A o Valdate Mew SIP Trunk From Template
~. 2 |
gy, 2 ;
~, 2 Mew From Template (Binary) { | ‘
= Cont Export as Template (Binary) — =
& 4 Extension (42 | ik P Asserted 1D ¥

5. In the subsequent Template Type Selection pop-up window, select United States from the
Country pull-down menu and select Cox Communications from the Service Provider pull-
down menu as shown below. These values correspond to parts of the file name
(CoxSIPTIPO9SBC.xml) created in Step 1. Click Create new SIP Trunk to finish
creating the trunk.

W Template Type Selection

Locale
Service Provider | Cox Communications v } [T] Display &l

[ Create new SIP Trunk ] [ Cancel ]

Country | nited States v l ‘

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.2.
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5.4.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line. On the SIP Line tab in the Details Pane, configure the
parameters as shown below:

e Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the

host portion of SIP URI in SIP headers such as the From header.

Set Send Caller ID to Diversion Header.
Check the In Service box.
Select SIP for URI Type

Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS

method to periodically check the SIP Line.

e Default values may be used for all other parameters.

The area of the screen entitled REFER Support is used to enable/disable SIP REFER for call

transfers. The default values of “Auto” for Incoming and Outgoing effectively disable use of SIP

REFER. To enable SIP REFER, select “Always” from the drop-down menu for Incoming and
Outgoing. In the compliance test, The REFER method was not tested since Cox system does not

support REFER at this point. Click OK to commit (not shown).

IP Offices

|- R BOOTP(7)
{7 Operator (3)
[+ System (1)

= e @]
1

o 2
-, 17
g, 18
w[19]
", 20
., 21
, 22
~, 23
[#-<=» Control Unit {4)
[+ 4@ Extension (43)
#-§  User (44)
[-5§ Group (7)
[+ @3 Short Code (67)
B Service (0)
Wy RAS (1)
- g9 Incoming Call Route 1
£ wanPort (0)
@ Directory {0)
£ Time Profile (0)
@@ Firewall Profile (1)
el IP Route (2)
| Account Code (0)
& License (41)
& Tunnel (0)
-3 User Rights (8)
[+ ARS (1)
&5 Location (0)
2% Authorization Code (

o-E-®

SIP Line -Line 19

SIP Line fTransport| SIP URI|YoIP | T38 Fax| SIP Credentials

Line Mumber

ITSP Domain Name

s 3

avavyalab.com

Prefix
Mational Prefix
Country Code

International Prefix

Send Caller ID
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Select the Transport tab. The ITSP Proxy Address is set to internal IP Address of Avaya SBCE.
As shown in Figure 1, this IP Address is 10.10.97.174. In the Network Configuration area, UDP is
selected as the Layer 4 Protocol, and the Send Port is set to the port number of Avaya SBCE. The
Use Network Topology Info parameter is set to LAN 1. This associates the SIP Line with the
parameters in the System - LAN1 - Network Topology tab. Other parameters retain default
values in the screen below. Click OK to commit (not shown).

SIP Line - Line 19 dv:ﬂlxwl<>>l
1P Line | Transport stp URavotp | 736 Fa 1P Credentis

ITSP Proxy Address |10.10.97.174 |

Metwork Configuration

Layer 4 Protocol |UDP v|  SendPort [5060 3|
Use Network Topology Info | LAN 1 v ;

Explicit DNS Server(s) | O 0 0 o |0 0 0 o |

Calls Route via Registrar

Separate Reqistrar
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab, click the Add button and then New Channel area will appear at
the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the

Edit..

. button. In the example screen below, a previously configured entry is edited. For the

compliance test, a single SIP URI entry was created that matched any DID number assigned to an
Avaya IP Office user. The entry was created with the parameters shown below:

Set Local URI, Contact and Display Name to Internal Data. This setting allows calls on
this line which SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.6.

Set PAI to Internal Data. With this setting IP Office will populate the SIP P-Asserted-
Identity header on outgoing calls with the data set in the SIP tab of the call initiating User as
shown in Section 5.6.

For Registration, select the account credentials previously configured on the line's SIP
Credentials tab. This is not used in this compliance testing.

Associate this line with an incoming line group in the Incoming Group field. This line
group number will be used in defining incoming call routes for this line. Similarly, associate
the line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 19 was defined that only contains this line (line 19).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

Click OK to commit

SIP URI entry for Channel 1.

B SIP Line - Line 19

SIP Line|| Transportd SIP URI ¥0IP | T38 Fax| SIP Credentials
Channel  Groups Via Local URI Contact Display Name PAI add...
1 19 19 i
2 19 19 1... 703663... 7036... Remove

Edit...
Edit Channel
— f
Via 10,10.97.39
Local URI B se Internal Data v |
Contact ;Use Internal Data v
Display Mame |Use Internal Data v
PAI ;EJse Internal Data ] v
Registration IJ <MNone> 1~
Incoming Group |19
Qutgoing Group |19
Max Calls per Channel |10 =
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SIP URI entry Channel 2 was similarly created for incoming calls appropriately to pre-define DID
numbers 7036638143 to access to Feature Name Extension 00 (FNEQO). The Short Codes for
FNEOO was defined in Section 5.5 to provide Dial Tone and Mobile Callback for mobility extension.

The Channel 2, as shown in the screenshot below, was configured with following parameters.
e Setthe Local URI and Contact fields to pre-define DID number 7036638143 appropriately
for Channel 2.
Associate Incoming Group and Outgoing Group to SIP Line 19.
Set the Max Calls per Channel field to 10.
Other parameters retain default values.
Click OK to commit.

SIP URI entry for Channel 2

= SIP Line - Line 19
|SIP Line TransportjE pIP URTjyoIP | T38 Fax| SIP Credentials
’ Channel  Groups Via Local URI Contact Display Mame PAI \ Add..
1 19 19 § B
2 19 19 1... 703663... 7036... Remove
Edit...
Edit Channel
— | oK |
Via ‘ 10,10,97.39
Local URI 7036638143 v |
Contact 7036635143 [ o
Display Mame ?Use Internal Data | v ‘
PAI lLlse Interné] Data i ] ; \
Reqgistration ‘U <MNone> VVT
—
Incoming Group 119
Qutgoing Group l19
Max Calls per Channel 10 3
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. Select G.711 ULAW 64K, codecs
cause Avaya IP Office to include this codec, supported by the Cox SIP Trunking service, in
the Session Description Protocol (SDP) offer.

e Set Fax Transport Support to G711 from the pull-down menu (T.38 faxing is not currently
supported by Cox).

e Setthe DTMF Support field to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Uncheck the VoIP Silence Suppression box. By unchecking the VolP Silence Suppression
box, calls can be established with the G.729 codec but without silence suppression. Since
Cox does not support G.729 at this point, this parameter is optional.

e Check the Re-invite Supported box.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

SIP Line -Line 19

SIP Line| Transport | SIP URI T38 Fax | SIP Credentials

I |:| YoIP Silence Suppressionl

[] allow Direct Media Path

Codec Selection Custom 7 | I Ra-fwits Stippoeted ]
Unused Selected
(G.711 ALAW 64K == | [G.711 ULaw 64K ] Codec Lockdown
6,722 64K ‘

PRACK/100rel Supported
| G.729(a) 8K CS-ACELP D ! o

|G.723.1 6K3 MP-MLQ Force direct media with phones

[] G.711 Fax ECAN

e

Fax Transport Support |G.711 v
Location Cloud v
Call Initiation Timeout (s) |4 ==

DTMF Support I:RFC2833 . v
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5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane, then right-click in the Group Pane and select New. On the Short
Code tab in the Details Pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “9ON;” short code used in the test
configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@avayalab.com”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the domain of the service
provider network.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.

e Set Locale to United State (US English).

e Click OK to commit (not shown).

IP Offices Short Code

®& BOOTP (7) Code Telephone Mumber -~ ‘
7 Operator (33 BIEISENE N
= “=r DevCon IPO 2 2336
==y System (1) Bx7FS102 :
T Line () [=a<on; NU@avayalab.com” |
= Control Unit {4) WX FrREOD oo

<& Extension (42) @3¢+a0
& User (44} @rctagq
Sg_Group o rqz

1
: v 7 2
B3¢ Short Code (672 ®x*as >

2

N

Code L= H

Feature Dial ~

Telephone Mumber MNY"@avayalab.com™

™

Line Group ID 119 ~ |

Locale United States (US English) ~

859 Service (0) o
LD =
§2 Incoming Call Route (113

Force Account Code 1

“.”.,,.zﬁm..,

Force Aauthorization Code [ ]

For incoming calls from mobility extension to FNE features hosted by IP Office to provide Dial
Tone functionality, Short Code FNEOO was created. The FNEOO was configured with the following
parameters.

In the Code field, enter the FNE feature code as FNEQO for Dial Tone.

Set the Feature field to FNE Service.

Set the Telephone Number field to 00 for FNEOQO.

Set the Line Group ID field to 0.

Retain default values for other fields.

Click OK to commit (not shown).

B FNEOO: FNE Service ek -8 | X |« < |

Code FREOO

Feature FME Service ~ |

Telephone Mumber oo

Line Group ID D ~|
Locale ~
Force Account Code il |

Force Authorization Code [ ]
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is “H323-29225”. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323-29225. The SIP Name and Contact are set to one
of the DID numbers assigned to the enterprise from Cox. The SIP Display Name (Alias) parameter
can optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered as private, then the Anonymous box may be checked to withhold the user’s
information from the network. Click OK to commit (not shown).

IP Offices Extn29225: 29225
= & & Dial In | Yoice Recording | Button Programming | Menu Programming | Mobility | Group Membership | Announcements
olser [ — - — 5 =
$rg RemoteManager SIP Name 7036635122
29225 Extn29225 ) i T—
39276 EXtN29226 SIP Display Name (Alias |H323-292: 5
& 29227 Extn29227 Contact [7036638122
§ 29233 Extn29233
&+ 29234 Extn29234
§ 29235 Extn29235 m

One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323-29225. The Mobility Features and Mobile Twinning
boxes are checked. The Twinned Mobile Number field is configured with the number to dial to
reach the twinned mobile telephone, in this case 96139675279. Other options can be set according to
customer requirements. Click OK to commit (not shown).

B Extn29225: 29225 ek - | X | < | >]

Button Programming | Menu Programming | Mobility | Group Membership | Announcements | SIP | Personal Directory | N
=

Mobility Features
Mobile Twinning

Twinned Mobile Number [o613967527a l
including dial access code) | i

Twinning Time Profile ‘ <MNone> ~ |

Mobile Dial Delay (secs) E‘ A

Mobile Answer Guard (secs) |0 =

[] Hunt group calls eligible For mobile twinning
[] Forwarded calls eligible For mobile bwinning

[] Twin When Logged Out B

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 21 of 53
SPOC 03/26/2014 ©2014 Avaya Inc. All Rights Reserved. CoxSIPTIPO9SBC



5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in
the center Group Pane and select New. On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
Set the Incoming Number to the incoming number on which this route should match.

e Set Locale to United State (US English).

e Default values can be used for all other fields.

e Click OK to commit (not shown).

IP Offices B 19 7036638122

#- & BOOTP (7) i' Yoice Recordiné Destinations |

[#-¢7~ Operator (3) a2 N ]

[=-*%=y DevCon IPO 2 |
[+ 53y System (1) Bearer Capability [Any Voice j
-7 Line (9) . — - —=
@<= Control Unit (4) Line Group ID 13 _ |
[+ - Extension (43) Incoming Nurber ’?036638122 w
@ User (44) - L
® 5% Group (7) Incoming Sub Address \ l
#-@% Short Code (67) _ = =

@ Service {0) Incoming CLI | ) _}
- RAS (1) B e R e e T e ||
Local United States {US English v |

= e Incoming Call Route {11) S ks A ) —!
Y10 7036638122 | Priarity 1 - Low v|

P 19 7036638126 -

@ 197036638133 Tad 1 d

: @ 197036638143 Hold Music Source ]System Source v J

£2 wanPort (0) L= =
@ Directory (0) Ring Tone Override Nane v

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 7036638122 on line 19 are routed to extension
29225. Click OK to commit (not shown).

IP Offices 19 7036638122 x-S X v]<]|>

= §P|Incoming Call Route {11

@ [19 7036635122
@ 197036635126

TimeProfile Destination Fallback Extension

@ 197036638133 > Default value | 29225 Extri29225 v v
M 10 FN3AAIA143
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5.8. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use the P-Preferred-ldentity (PPI)
or P-Asserted-Identity (PAI) header to pass the actual calling party information for authentication
and billing. For the compliance test, Cox does not use either PPI or PAI for the purposes of privacy.

5.9. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. The rate at which the messages are sent is determined by the combination of the Binding
Refresh Time (in seconds) set on the Network Topology tab in Section 5.1 and the
SIP_OPTIONS_PERIOD parameter (in minutes) that can be set on the Source Number tab of the
noUser user. The OPTIONS period is determined in the following manner:

e Ifno SIP_OPTIONS_PERIOD parameter is defined and the Binding Refresh Time is 0,
then the default value of 44 seconds is used.

e To establish a period less than 42 seconds, do not define a SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 42 secs. The OPTIONS
message period will be equal to the Binding Refresh Time.

e To establish a period greater than 42 seconds, a SIP_OPTIONS_PERIOD parameter must
be defined. The Binding Refresh Time must be set to a value greater than 42 secs. The
OPTIONS message period will be the smaller of the Binding Refresh Time and the
SIP_OPTIONS_PERIOD.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User = noUser in the
Navigation / Group Panes. Select the Source Numbers tab in the Details Pane. Click the Add button
(not shown). At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

B NoUser: ek - X |« | < =
User Yoicemail DrD Short Codes Source rHumbers Telephony Forwsar ding Dial In Yoice Recording Button Pri € >
Source rumber Add...
Remove
Edit...
Edit Source RNumber
lsource rumber SIP_OPTIOMNS_PERIOD=2Z2 l

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. For the compliance test, an OPTIONS period of 1 minute was desired. The Binding
Refresh Time was set to 60 seconds (1 minute) in Section 5.1. The SIP_OPTIONS_PERIOD
was set to 2 minutes. Avaya IP Office chose the OPTIONS period as the smaller of these two
values (1 minute). Click the OK button (not shown).

User Yoicemail | DND Short Codes Telephony | Forwarding | Dial In | VYoice Recording | Button Pri. € »

Source Number Aadd...

[5IF_GPTIONS _PERIOD=2]

Remove
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5.10. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Configure the Avaya Session Border Controller for
Enterprise

This section covers the configuration of the Avaya SBCE. It is assumed that the software has already
been installed. For additional information on these configuration tasks, see Error! Reference source
not found. Error! Reference source not found., Error! Reference source not found. and Error!

Reference source not found..

The compliance testing comprised the configuration for two major components, Trunk Server for the
service provider and Call Server for the enterprise. Each component consists of a set of Global
Profiles, Domain Policies and Device Specific Settings. The configuration was defined in the Avaya
SBCE web user interface as described in the following sections.

Trunk Server configuration elements for the service provider - Cox:
e Global Profiles:

o

O O O O

(@]

URI Groups

Routing

Topology Hiding
Server Interworking
Signaling Manipulation
Server Configuration

e Domain Policies:

©)
@)
©)
@)
©)

Application Rules
Media Rules

Signaling Rules
Endpoint Policy Group
Session Policy

e Device Specific Settings:

o

o O O O

Network Management

Media Interface

Signaling Interface

End Point Flows = Server Flows
Session Flows

Call Server configuration elements for the enterprise - IP Office:
e Global Profiles:

©)
@)

O

©)
@)

URI Groups

Routing

Topology Hiding
Server Interworking
Server Configuration

e Domain Policies:

O

@)
©)
@)

Application Rules
Media Rules

Signaling Rules
Endpoint Policy Group
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o Session Policy
e Device Specific Settings:

o Network Management
Media Interface

Signaling Interface
End Point Flows - Server Flows
Session Flows

0 O O O

6.1. Log into the Avaya Session Border Controller for Enterprise

Use a Web browser to access the Avaya SBCE Web interface, enter https://<ip-addr>/SBCE in the
address field of the web browser, where <ip-addr> is the management IP address.

Enter the appropriate credentials then click Log In.

for Enterprise

AVAYA

Session Border Controller

Log In
Username: ucsec
Password: eeeccccscscscscscce

This system is restricted solely to authorized users for legitimate
business purposes only. The actual or attempted unauthorized access,
use or modifications of this system is strictly prohibited. Unauthorized
users are subject to company disciplinary procedures and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The use of this system may be monitored and recorded for
administrative and security reasons. Anyone accessing this system
expressly consents to such monitoring and recording, and is advised
that if it reveals possible evidence of criminal activity, the evidence of
such activity may be provided to law enforcement officials.

All users must comply with all corporate instructions regarding the
protection of information assets.

® 2011 - 2012 Avaya Inc. Allrights reserved.

The Dashboard main page will appear as shown below.

Dashboard

Administration

Backup/Restore

System Management
Global Parameters
Global Profiles

> SIP Cluster
Domain Policies

Dashboard

Session Border Controller for Enterprise AVAYA

System Time

Version

Build Date

05:41:52 PM GMT Refresh EMS

mSBCE

Mon Dec 9 17:33:02 CST 2013

Alarms (past 24 hours) Incidents (past 24 hours)

None found. mSBCE: Heartbeat Successfull, Server is UP
TLS Management
> Device Specific Settings mSBCE: Heartbeat Failed, Server is Down
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To view system information that has been configured during installation, navigate to System
Management. A list of installed devices is shown in the right pane. In the compliance testing, a
single Device Name mSBCE was already added. To view the configuration of this device, click the
View as shown in the screenshot below.

Session Border Controller for Enterprise AVAYA

Dashboard System Management
Administration

Backup/Restore

Devicesll Updates I l SSL VPN I | Licensing

I System Management I

Global Parameters Device Name ~Management
> Global Profiles

SIP Cluster Tpggggzoooz) 10.10.98.70  6.2.0.Q30 Commissioned Reboot Shutdown Restart Application JViewl] Edit Delete

Version Status

{Serial Number) IP

Domain Policies

The System Information screen shows Network Settings, DNS Configuration and
Management IP information provided during installation and corresponded to Figure 1. The Box
Type was set to SIP and the Deployment Mode was set to Proxy. Default values were used for all
other fields.

System Information: mSBCE X

- General Configuration Device Configuration

Appliance Name mSBCE HA Mode No

Box Type SIP Two Bypass Mode No

Deployment Mode Proxy

- Network Configuration

Public IP Netmask Gateway Interface
10.10.97.174 10.10.97.174 255.255.255.192 10.10.97.129
192.168.1.200 192.168.1.200 2552552550 192.168.1.1
- DNS Configuration Management IP(s)
Primary DNS 10.10.98.60 l'm
Secondary DNS
DNS Location DMZ
DNS Client IP 10.10.97.174
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6.2. Global Profiles
Global Profiles allows for configuration of parameters across all Avaya SBCE appliances.

6.2.1. Uniform Resource ldentifier (URI) Groups

URI Group feature allows user to create any number of logical URI groups that are comprised of
individual SIP subscribers located in that particular domain or group. These groups are used by the
various domain policies to determine which actions (Allow, Block, or Apply Policy) should be used
for a given call flow.

In the Compliance testing, URI Group is not used for any specific defined group but rather the
general identifier “*”’.

6.2.2. Routing Profiles

Routing profiles define a specific set of packet routing criteria that are used in conjunction with other
types of domain policies to identify a particular call flow and thereby ascertain which security
features will be applied to those packets. Parameters defined by Routing profiles include packet
transport settings, name server addresses and resolution methods, next hop routing information and
packet transport types.

To create a Routing profile, select Global Profiles & Routing then click on the Add Profile button
(not shown).

In the compliance testing, Routing profile To-SP was created to be used in conjunction with Server
Flow (see Section 6.4.4) defined for IP Office. This entry is to route outgoing calls from the
enterprise to Cox.

On the opposite direction, Routing profile To_IPO_97_39 was created to be used in conjunction
with Server Flow (see Section 6.4.4) defined for Cox. This entry is to route incoming calls from Bell
to the enterprise.
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6.2.2.1 Routing Profile for Cox

To display Edit Routing Rule dialog of Routing profile To-SP, select Global Profiles = Routing:
To-SP. As shown in the screenshot below, if there is a match on the SIP domain of the “To” header
with the URI Group SP defined in Section 6.2.1, outgoing calls will be routed to the Next Hop
Server 1 as defined as 192.168.1.1 which is the IP address of Cox Trunk Server.

As shown in Figure 1, Cox SIP Trunking was connected with transportation protocol UDP. The
other options were kept as default.

Edit Routing Rule xX

URI Group I = ~ l

S e e i [ 19236811 |

Next Hop Server 2

IP. IP:Port. Domain. or Domain:Port

e

Use Next Hop =1

for In Dialog Messages

Ignore Route Header . =1

for Messages Outside Dialog

NAPTR =1

SRV =

Outgoing Transport & 1S S TCP
[ |

6.2.2.2 Routing Profile for Avaya IP Office

Similarly, Routing profile To_IPO_97 39 was created to route incoming calls to the Next Hop
Server 1 as defined as 10.10.97.39 which is the IP address of IP Office, on port 5060 if there is a
match on the SIP domain of the “To” header with the URI Group SP defined in Section 6.2.1. As
shown in Figure 1, IP Office was connected with transportation protocol UDP.

To display Edit Routing Rule dialog of Routing profile To_IPO_97 39, select Global Profiles >
Routing: To_IPO_97_39 then click Edit (not shown)

Edit Routing Rule x

Each URI group may only be used once per Routing Profile.

Next Hop Routing
URI Group = [=1

Next Hop Server 1 10} 10.97.35-5060

1P, IP:Port. Domain. or Domain:Port

Next Hop Server 2

1P, IP:Port, Domain. or Domain:Port

Rolifp Ena st =
$or In Diwiog Massages =
O e e Tiaiog =
NAPTR =
SRV =i
Outgoing Transport S JTLS: ® TJCP
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6.2.3. Topology Hiding

Topology Hiding is a security feature of the Avaya SBCE which allows changing certain key SIP
message parameters to ‘hide’ or ‘mask’ how the enterprise network may appear to an unauthorized
or malicious user.

To create a Topology Hiding profile, select Global Profiles > Topology Hiding then click on the
Add Profile (not shown).

In the compliance testing, two Topology Hiding profiles were created: To-SP and To_IPO_97 39.

6.2.3.1 Topology Hiding Profile for Cox

Topology Hiding profile To-SP was defined for outgoing calls to Cox to:
e Mask URI-Host of the “Request-URI” and “To” headers with service provider SIP domain
coxbusiness.com to meet the requirements of Cox.
e Mask URI-Host of the “From” header to service provider SIP domain coxbusiness.com.

This implementation is to secure the enterprise network topology and also to meet the SIP
requirements from the service provider.

The screenshots below illustrate the Topology Hiding profile To-SP

Edit Topology Hiding Profile

Header Criteria Replace Action Overwrite Value
SDP v IP/Domain v Auto v Delete
Referred-By v IP/Domain ~ Auto - Delete
To v IP/Domain ~ Overwrite v coxbusiness.com Delete
Refer-To v |IP/[Domain ~ Auto v Delete
Via v |P/Domain v Auto v Delete
Request-Line v IP/Domain ~ Overwrite v coxbusiness.com Delete
From v IP/[Domain ~ Overwrite v coxbusiness.com Delete
Record-Route ~ |P/Domain v Auto v Delete
| Finish |
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6.2.3.2 Topology Hiding Profile for IP Office

Topology Hiding profile To_IPO_97_39 was defined for incoming calls to IP Office to:
e Mask URI-Host of the “Request-URI”, “To”, and “From” headers with the enterprise SIP
domain avayalab.com.
e Leave the “Record-Route”, “Via” headers and SDP to default Auto.

The screenshots below illustrate the Topology Hiding profile To_IPO_97 309.

Edit Topology Hiding Profile X

Header Criteria Replace Action Overwrite Value
SDP - IP/Domain -~ Auto -~ Delete
Referred-By -~ IP/Domain -~ Auto -~ Delete
To -~ IP/Domain -~ Overwrite -~ avayalab.com Delete
Refer-To -~ IP/Domain -~ Auto -~ Delete
Via -~ IP/Domain -~ Auto -~ Delete
Request-Line - IP/Domain - Overwrite - avayalab.com Delete
From - IP/Domain - Overwrite IL] avayalab.com Delete
Record-Route -~ IP/Domain -~ Auto -~ Delete
[ Finish ||

6.2.4. Server Interworking

Server Interworking profile features are configured differently for Call Server and Trunk Server.
To create a Server Interworking profile, select Global Profiles = Server Interworking then click
on the Add Profile button (not shown). In the compliance testing, two Server Interworking profiles
SP-Sl and IPO_97_39 were created for Cox (Trunk Server) and IP Office (Call Server).

6.2.4.1 Server Interworking Profile for Cox

Server Interworking profile SP-SI was defined to match the specification of Cox. The General and
Advanced tabs were configured with the following parameters while the other tabs Timers, URI
Manipulation and Header Manipulation were kept as default. General settings are being set as
shown in capture bellow. Others are left as default

Hold Support = RFC2543 - <=0.0. 0.0
RFC32264 - a=sendonly

1380 Handling None E sSDP 7 No SDP

121 Handling None E sSDP E No SDP

1382 Handling None - sSDP = No SDP

1283 Handling None = sSDP = No SDP

Refer Handling
3xx Handling

Diversion Header Support
Delayed SDP Handling i |

T.38 Support =

URI Scheme =L ANY
wia Header Format | =i RIS S 1
e
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Advanced settings are being set as shown in capture bellow and others are left as default.

Editing Profile: SP-_SI1 x

H one
Record Routes ' Single Side
Topology Hiding: Change Call-ID 4|
Call-Info NAT | [}
Change Max Forwards
Include End Point IP for Context Lookup =1
OCS Extensions =1
ANVAY A Extensions [l |
NORTEL Extensions =1
Diversion Manipulation =l
Diversion Header URI
Metaswitch Extensions =
Reset on Talk Spurt [ |
Reset SRTP Context on Session Refresh | [}
Has Remote SBC
Route Response on Via Port =
Cisco Extensions [l |

6.2.4.2 Server Interworking Profile for IP Office

Server Interworking profile IPO_97 39 shown in the screenshots below, was similarly defined to
match the specification of IP Office with the exception of the support for Avaya Extensions was

enabled.

Editing Profile: IPO_97_ 39 4

Heold Support

180 Handling
121 Handling
122 Handling
1232 Handling
Refer Handling

3Ixx Handling

Driversion Header Support

Delayed SDP Handling =

T.38 Support

URI Scheme

Wia Header Format

@ Mone I SDP
@ Mone " SDP
@ MNone = SDP
@ MNone| T SDP
=1

[l

]|

© TeL

| = rFc3zel |
T RFC2543

General

! RFC3264 - a=sendonly

' Mo SDP

' Mo SDP

' Mo SDP

= Mo SDP

rANY
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Advanced settings are being set as shown in capture bellow and others are left as default.

Editing Profile: IPO_97_ 39 > |
None
Record Routes Single Side
Topology Hiding: Change Call-ID
Call-Info NAT =l
Change Max Forwards
=

Include End Point IP for Context Lookup
OCS Extensions [l
AVAY A Extensions =]
NORTEL Extensions =l
Diversion Manipulation
Diversion Header URI
Metaswitch Extensions [
Reset on Talk Spurt =1
Reset SRTP Context on Session Refresh =

Has Remote SBC

Route Response on Via Port

Cisco Extensions =l

[Fmen 1
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6.2.5. Server Configuration

Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and
Advanced. These tabs are used to configure and manage various SIP Call Server specific parameters
such as TCP and UDP port assignments, heartbeat signaling parameters, DoS security statistics and
trusted domains.

To create a Server Configuration entry, select Global Profiles > Server Configuration then click
on the Add Profile button (not shown).

In the compliance testing, two separate Server Configurations were created, server entry SP-SC for
Cox and server entry IPO_97_39 for IP Office.

6.2.5.1 Server Configuration for Cox

The Server Configuration SP-SC was added for Cox, it is discussed in detail as below. The General
and Advanced tabs were provisioned. The Heartbeat tab, however, was disabled as default to allow
the Avaya SBCE to forward the OPTIONS heartbeat originated from IP Office to Cox to query for
the status of the SIP Trunk. The Authentication tab was also kept disabled as default. The General
setting for Server Configuration SP-SC is being set as shown in following capture.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
minetraon [m l Rename ] l Clone ] ] Delete
Backup/Restore
Server Profiles |Genera| | I Authentication I | Heartbeat I | Advanced | [ DoS Whitelist ) I DoS Protection '
System Management
IPO
Global Parameters Server Type Trunk Server
MTSAll
“[ Global Profiles Gl IP Addresses / FQDNs 192.168.1.1
Domain DoS
) 3 P0_97_39 Supported Transports UDP
Fingerprint e
Server Interworking UDP Port 2060
Phone Interworking kT Edit
Media Forking SP-SC
Routing
IServer Configuration |
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The Advanced setting is being set as shown in capture. Where the SP-SI Interworking Profile is
selected as defined in Section 6.2.4.1.

Session Border Controller for Enterprise AVAYA

Dashboard Server Configuration: SP-SC
Administration

Add [ Rename ][ Clone H Deletej
General H Authentication ‘ I Heartbeat I %IAdvanced “ DoS Whitelist H DoS Protection I
System Management : g

| SP-SC |
Global Parameters Enable DoS Protection v

4 Global Profiles

Backup/Restore

Enable Grooming [

Domain DoS —
Fingerprint Interworking Profile SP-SI
Server Interworking Signaling Manipulation Script None

Phone Interworking UDP Connection Type SUBID

Media Forking
Routing

I Server Configuration ]

6.2.5.2 Server Configuration for Avaya IP Office

The Server Configuration IPO_97_39 was similarly created for IP Office. It is discussed in detail as
below. Only the General and Advanced tabs required provisioning. The Heartbeat tab was kept
disabled as default to allow the Avaya SBCE to forward the OPTIONS heartbeat from Cox to IP
Office to query for the status of the SIP Trunk. The General setting for Server Configuration
IPO_97 39 is being set as shown in following capture.

Session Border Controller for Enterprise AVAYA
4 Global Profiles +  Server Configuration: IPO_97_39

Domain DoS Add [ Rename H Clone H Delete ]

Fingerprint ‘ IGeneral ” Authentication I | Heartbeat I | Advanced |

Server Interworking !

Phone Interworking | Server Type Call Server

Media Forking IP Addresses / FQDNs 10.10.97.39

Routing Supported Transports UDP

ézxiegruration HOR Foxs i
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The Advanced setting is being set as shown in capture. Where the IPO_97_39 Interworking Profile
is selected as defined in Section 6.2.4.2.

Session Border Controller for Enterprise AVAYA
4 Global Profiles » Server Configuration: IPO_97_39
Domain DoS Add [ Rename | [ Clone | [ Delete |
Fingerprint General || Authentication I I Heartbeat | ilAdvancedI%
Server Interworking -
- |0 _97 39
Phone Interworking 1 |—| Enable DoS Protection [ [
Media Forking Enable Grooming [
Routing ; |
Sarves Interworking Profile =
Configuration Signaling Manipulation Script None
Topology Hiding UDP Connection Type SUBID
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6.3. Domain Policies

Domain Policies feature configures various rule sets (policies) to control unified communications
based upon criteria of communication sessions originating from or terminating at the enterprise.
These criteria can be used to trigger policies which, in turn, activate various security features of the
Avaya SBCE security device to aggregate, monitor, control and normalize call flow. There are
default policies available for use, or a custom domain policy can be created.

6.3.1. Application Rules

Application Rules define which types of SIP-based applications the Avaya SBCE security device
will protect: voice, video, and/or instant messaging (IM). In addition, it is possible to configure the
maximum number of concurrent voice and video sessions the network will process in order to
prevent resource exhaustion.

For the certification testing, Application Rule was created to set the number of concurrent voice
traffic. The sample configuration cloned and modified the default application rule to increase the
number of Maximum Concurrent Session and Maximum Sessions Per Endpoint.

To clone an application rule, navigate to Domain Policies = Application Rules, select the default
rule then click on the Clone Rule button (not shown).

Enter a descriptive name e.g. SP-AR for the new rule, then click on the Finish button (not shown). Click
Edit button to modify the rule. Set the Maximum Concurrent Sessions and Maximum Session
Per Endpoint for the Voice application to a value high enough for the amount of traffic the network
is able process. The following screen shows the modified Application Rule.

Session Border Controller for Enterprise AVAYA

Pashboard Application Rules: SP-AR

JAdministration

Add Filter By Device... [ Rename ][ Clone ” Delete ]
Backup/Restore

sl iirasened Application Rules Click here to add a description.

Global Parameters - Application Rule
Siatel Propics Application T Maximum Concurrent  Maximum Sessions
> SIP Cluster ype Sessions Per Endpoint
¢ Domain Policies Voice @ @ | 1000 1000
[Application Rules
Video Fl F
Border Rules
Media Rules M B B
Security Rules
T
Time of Day Rules COR Support hons
End Point Policy RTCP Keep-Alive No
Groups o)
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6.3.2. Media Rules

Media Rules define RTP media packet parameters such as prioritizing encryption techniques and
packet encryption techniques. Together these media-related parameters define a strict profile that is
associated with other SIP-specific policies to determine how media packet matching the criteria will
be handled by the Avaya SBCE security product.

A custom Media Rule was created to set the Quality of Service and Media Anomaly Detection.
The sample configuration showed Media Rule SP-MR which was used for both the enterprise and
Cox networks.

To create a Media Rule, navigate to Domain Policies > Media Rules, select the default-low-med
rule then click on the Clone Rule button (not shown).

Enter a descriptive name e.g. SP-MR for the new rule, then click on Finish button (not shown).
Under Media QoS tab, then click on Edit button (not shown) to configure the Quality of Service
(QoS). The Avaya SBCE can be configured to mark the Differentiated Services Code Point (DSCP)

in the IP packet header with specific values to support Quality of Services policy for the media.

The following screen shows the QoS values used for the compliance testing.

Session Border Controller for Enterprise AVAYA
Dashboard Media Rules: SP-MR

Pdministration Filter By Device... [~] [ Rename | [ Clone || Delete |
packep ustore Click here to add a description.

System Management

__SP-MR | i
Global Parameters Media NAT | | Media Encryption | | Media Anomaly | | Media Silencing || Media QoS
Gt Proflics
> SIP Cluster =
- RTCP Enabled ([
b Domain Policies
Application Rules Media QoS Marking
Border Rules Enabled E
Media Rules
Security Rules QoS Type il
Signang Ruies
Time of Day Rules Audio DSCP
End Point Policy
Groups Video QoS
Session Policies Video DSCP
TLS Management _
Device Specific Settings i
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6.3.3. Signaling Rules

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by the Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

To clone a signaling rule, navigate to Domain Policies = Signaling Rules, select the default rule
then click on the Clone Rule button (not shown).

In the compliance testing, two Signaling Rules were created for Cox and IP Office.

6.3.3.1 Signaling Rule for Cox

Clone a Signaling Rule with a descriptive name e.g. SP-SR and click on the Finish button (not
shown).

Cloning the Signaling Rule default, verify that General settings of SP-SR with Inbound and
Outbound Request were set to Allow, and Enable Content-Type Checks was enabled with Action
and Multipart-Action were set to Allow (not shown).

On the Signaling QoS tab, select the proper Quality of Service (QoS). The Avaya SBCE can be
configured to mark the Differentiated Services Code Point (DSCP) in the IP packet header with
specific values to support Quality of Services policies for signaling.

The following screen shows the QoS value used for the compliance testing.

Session Border Controller for Enterprise AVAYA
> Global P i 2 i
obalFarameters Signaling Rules: SP-SR
Global Profiles
SIP Cluster Add Filter By Device.. [~] [ Rename ”[ Clone ][ Delete ]
icati SP-SR
Spplication Rules G | H Requests I l Responses I l Request Headers l l Response Headers I l Signaling QoS |
Border Rules
Media Rules Signaling QoS 7
Security Rules QoS Type DSCP
2 DSCP EF
Time of Day Rules
End Point Policy [(Ed] |
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6.3.3.2 Signaling Rule for IP Office

Clone a Signaling Rule with a descriptive name e.g. IPO_97_39 SR for IP Office and click on the
Finish button (not shown).

Cloning the Signaling Rule default, verify that General settings of IPO_97_39 SR with Inbound
and Outbound Request were set to Allow, and Enable Content-Type Checks was enabled with

Action and Multipart-Action were set to Allow (not shown)..

Similarly the Signaling QoS rules are set as shown in Figure bellow.

> Global Profiles

> SIP Cluster

4 Domain Policies
Application Rules
Border Rules
Media Rules

-

Session Border Controller for Enterprise

Signaling Rules: IPO_97_39_SR

Add

Filter By Device...

AVAYA

[ Rename ] [ Clone H Delete ]

Signaling Rules Click here to add a description.

default

No-Content-T...

General | | Requests || Responses | | Request Headers || Response Headers H ISvgnaImg QoS”

Security Rules IPO_SR SN Qo5 -

MTSAllstrea... QoS Type DSCR

Time of Day Rules E| CL SR DSCP EF

ER TR fPos7 3. 58] =0
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 40 of 53
SPOC 03/26/2014 ©2014 Avaya Inc. All Rights Reserved. CoxSIPTIPO9SBC



6.3.4. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to Server Flow defined in Section 6.4.4.

Endpoint Policy Groups were separately created for Cox and IP Office.

To create a policy group, navigate to Domain Policies = Endpoint Policy Groups and click on the
Add Group button (not shown).

6.3.4.1 Endpoint Policy Group for Cox

The following screen shows SP-PG created for Cox.

Set Application Rule to SP-AR which was created in Section 6.3.1.
Set Media Rule to SP-MR which was created in and Section 6.3.2.
Set Signaling Rule to SP-SR which was created in Section 6.3.3.1.
Set Border and Time of Day rules to default.

Set Security rule to default-high.

Session Border Controller for Enterprise AVAYA

4 Domain Policies

Policy Groups: SP-PG

Application Rules

Border Rules Fiter By Device.. [=]
Media Rules
Security Rules SP-PG
g ¥ Hover over a row to see its description.
Signaling Rules
Time of Day Rules Policy Group
End Point Policy
el
Session Policies Order Application  Border Media Security  Signaling Tig\:yof
> TLS Management Y
> Device Specific Settings | 1 SP-AR default SP-MR high SP-SR default Edit Clone
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6.3.4.2 Endpoint Policy Group for IP Office

The following screen shows policy group IPO_97_39_PG created for IP Office.
Set Application Rule to SP-AR which was created in Section 6.3.1.

Set Media Rule to SP-MR which was created in and Section 6.3.2.

Set Signaling Rule IPO_97 39 SR which was created in Section 6.3.3.2.
Set the Border and Time of Day rules to default.

Set the Security rule to default-low.

Session Border Controller for Enterprise AVAYA

EEESERRGERE E Policy Groups: IPO_97_39_PG
Application Rules

Border Rules Add Filter By Device... [~
Security Rules {1IPO_97 39 PG |
3 _ Hover over a row to see its desc:ip!ion.
Signaling Rules
Time of Day Rules Policy Group
(E;nd Point Policy
roups
Session Policies Order Application Border Media Security Signaling T'g:yd
b TLS Management
SoAats , [ 1 SPAR  default SPMR %MWl po 97 39 SR defaut  Edit Clone |
» Device Specific Seftings oW
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6.4. Device Specific Settings

Device Specific Settings feature allows aggregate system information to be viewed and various
device-specific parameters to be managed to determine how a particular device will function when
deployed in the network. Specifically, it gives the ability to define and administer various device-
specific protection features such as Message Sequence Analysis (MSA) functionality and protocol
scrubber rules, end-point and session call flows, as well as the ability to manage system logs and
control security features.

6.4.1. Network Management

Network Management page is where the network interface settings are configured and enabled.
During the installation process of the Avaya SBCE, certain network-specific information is defined
such as device IP address, public IP address, subnet mask, gateway, etc. to interface the device to the
networks. This information populates the various Network Management tabs which can be edited as
needed to optimize device performance and network efficiency.

Navigate to Device Specific Settings = Network Management, under Network Configuration
tab; verify the IP addresses assigned to the interfaces and that the interfaces were enabled. The
following screen shows the private interface was assigned to Al and the public interface was
assigned to B1 appropriate to the parameters shown in the Figure 1.

For this compliance testing, Cox requirement is that any device connecting to their EdgeMarc should
be on the same subnet with the EdgeMarc itself. Therefore, the external interface (B1) of the Avaya
SBCE is specified with the IP address of 192.168.1.200, where IP address of the EdgeMarc is
192.168.1.1.

Session Border Controller for Enterprise AVAYA
Pashboard Network Management: mSBCE
JAdministration
Backup/Restore n
Network Configuration || | Interface Configuration
ISystem Management
I -_mSBCE
Global Parameters Modifications or deletions of an IP address or its associated data require an application restart
> Global Profiles before taking effect. Application restarts can be issued from System Management.
* SIP Cluster A1 Netmask A2 Netmask B1 Netmask
> Domain Policies 255.255.255.192 255.255.255.0
» TLS Management Add Save
[* Device Specific Settings IP Address Public IP Gateway Interface
Network -
Management 135.1097.174 135.10.97.129 Al v Delete
Media Interface 192.168.1.200 192.168.1.1 Bl | v Delete
Signaling Interface
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On the Interface Configuration tab, enable the interfaces connecting to the inside enterprise and
outside service provider networks. To enable an interface click it’s Toggle State button. The
following screen shows interface Al and B1 were Enabled.

Session Border Controller for Enterprise AVAYA
> TLS Management » Network Management: mSBCE
4 Device Specific Settings
copesi Network Configuration [ ! Interface Configuration I
Management | §
Vieda Interace bt |
Signaling Interface [A1 Enabled Toggle|
Signaling Forking A2 Enabled Toggle
EndiRaibtilcs 1 |B1 Enabled Toggle |
Session Flows ‘ ‘

6.4.2. Media Interface

Media Interface screen is where the media ports are defined. The Avaya SBCE will open connection
for RTP traffic on the defined ports.

To create a new Media Interface, navigate to Device Specific Settings = Media Interface and
click on the Add Media Interface button (not shown).

Two separate Media Interfaces are needed for both the inside and outside interfaces. The following
screen shows the Media Interfaces InsideMedia and OutsideMedia were created for the compliance
testing.

Note: After the media interfaces are created, an application restart is necessary before the changes
will take effect.

Session Border Controller for Enterprise AVAYA
Dashboand Media Interface: mSBCE

JAdministration

Backup/Restore : :

System Management WI

> Global Parameters

Modifying or deleting an existing media interface will require an application restart before taking
Global Profiles effect. Application restarts can be issued from System Management.

SIP Cluster
> Domain Policies

Name Media IP Port Range
» TLS Management
: 7 : InsideMedia 135.10.97.174 35000 - 40000 Edit Delete
‘I Device Specific Settings |
Network Management OutsideMedia 192.168.1.200 35000 - 40000 Edit Delete
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6.4.3. Signaling Interface

Signaling Interface screen is where the SIP signaling port is defined. The Avaya SBCE will listen for
SIP request on the defined port.

To create a new Signaling Interface, navigate to Device Specific Settings - Signaling Interface
and click on the Add Signaling Interface button (not shown).

Two separate Signaling Interfaces are needed for both inside and outside interfaces. The following
screen shows the Signaling Interfaces InsideSIP and OutsideSIP were created in the compliance
testing with TCP/5060 and UDP/5060 respectively configured for inside and outside interfaces.

Session Border Controller for Enterprise AVAYA
System Management Signaling Interface: mSBCE
Global Parameters
Global Profiles ;
Signaling Interface
> SIP Cluster e
m
> Domain Policies Add
TSN amagemen Name Signaling P [t S0P IS 718 Profle
4 | Device Specific Settings | & g o
Network Management InsideSIP 135.10.97.174 - 5060 - None Edit Delete
Media Interface OutsideSIP 192.168.1.200 5060 — None Edit Delete
| Signaling Interface |

6.4.4. End Point Flows - Server Flow

When a packet is received by the Avaya SBCE, the content of the packet (IP addresses, URIs, etc.) is
used to determine which flow it matches. Once the flow is determined, the flow points to a policy
which contains several rules concerning processing, privileges, authentication, routing, etc. Once
routing is applied and the destination endpoint is determined, the policies for this destination
endpoint are applied. The context is maintained, so as to be applied to future packets in the same
flow. The following screen illustrates the flow through the Avaya SBCE to secure a SIP Trunk call.

1P-POX

SP Trunk Service Provider
-
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In the compliance testing, two separate Server Flows were created for Cox and IP Office.

To create a Server Flow, navigate to Device Specific Settings = End Point Flows, select the
Server Flows tab and click on the Add Flow button (not shown). In the new window that appears,
enter the following values while the other fields were kept as default.

Flow Name: Enter a descriptive name.

Server Configuration: Select a Server Configuration created in Section 6.2.5 which the
Server Flow associates to.

URI Group: Select the URI Group SP created in Section 6.2.1.

Received Interface: Select the Signaling Interface created in Section 6.4.3 which is the
Server Configuration is designed to receive SIP signaling from.

Signaling Interface: Select the Signaling Interface created in Section 6.4.3 which is the
Server Configuration is designed to send the SIP signaling to.

Media Interface: Select the Media Interface created in Section 6.4.2 which is the Server
Configuration is designed to send the RTP to.

End Point Policy Group: Select the End Point Policy Group created in Section 6.3.4.
Routing Profile: Select the Routing Profile created in Section 6.2.2 which is used to which
is the Server Configuration is designed to route the calls to.

Topology Hiding Profile: Select the Topology Hiding profile created in Section Error!
Reference source not found. to apply toward the Server Configuration.

Use default values for all remaining fields. Click Finish to save and exit.

The following screen shows the Server Flow SP for Cox.

Edit Flow: SP X

Flow Name SP

Server Configuration SP-SC -

URI Group - -
Transport 7 -

Remote Subnet i

Received Interface InsideSIP  ~
Signaling Interface OutsideSIP ~

Media Interface OutsideMedia ~
End Point Policy Group SP-PG -
Routing Profile To_IPO_97_39 -
Topology Hiding Profile To-SP -
File Transfer Profile None ~
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Similarly, the following screen shows the Server Flow IPO_97 39 for IP Office

Edit Flow: IPO_97_39 X

Flow Name JPO_97_39
Server Configuration IPO_97_39 v
URI Group i v
Transport % v

Remote Subnet

Received Interface OutsideSIP ~

Signaling Interface InsideSIP ~

Media Interface InsideMedia ~

End Point Policy Group IPO_97_39_PG -
Routing Profile To-SP v
Topology Hiding Profile To_IPO_97_39 v

File Transfer Profile None ~

Finish
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6.4.5. Session Flows

Session Flows feature allows defining certain parameters that pertain to the media portions of a call,
whether it originates from the enterprise or outside the enterprise. This feature provides the complete
and unparalleled flexibility to monitor, identify and control very specific types of calls based upon
these user-definable parameters. Session Flows profiles SDP media parameters, to completely
identify and characterize a call placed through the network.

A common Session Flow SP-SF was created for both the Bell and IP Office.

To create a Session Flow, navigate to Device Specific Settings - Session Flows then click on the
Add Flow button (not shown). In the new window that appears, enter the following values while the
remaining fields were kept as default.
e Flow Name: Enter a descriptive name.
e URI Group #1: Select the URI Group SP created in Section 6.2.1 to assign to the Session
Flow as the source URI Group.
e URI Group #2: Select the URI Group SP created in Section 6.2.1 to assign to the Session
Flow as the destination URI Group.
e Session Policy: Select the Session Policy SP-SP created in Section Error! Reference source
not found. to assign to the Session Flow.
e Click on the Finish button.

Note: A unique URI Group is used for source and destination, since it contains multiple URIs
defined for the source as well as for the destination.

The following screen shows the Session Flow named SP-SF.

Edit Flow: SP-SF X

Flow Name KP-SF

URI Group #1 5 v
URI Group #2 i v
Subnet #1 *

Ex: 192.168.0.1/24

Subnet #2 *
Ex: 192.168.0.1/24

Session Policy SP-SP v

| Finish |
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7. Cox SIP Trunking Configuration

Cox is responsible for the configuration of Cox SIP Trunking service. It is also worth to mention
here that Edgewater EdgeMarc 4550 device running in B2BUA mode is part of Cox solution and
Cox is responsible for configuration and support it. The customer will need to provide the IP
address used to reach the Avaya IP Office at the enterprise. Cox will provide the customer the
necessary information to configure the Avaya IP Office SIP connection to Cox. The provided
information from Cox includes:

e [P address of the Cox SIP proxy.
Supported codecs.
DID numbers.
IP addresses and port numbers used for signaling or media through any security devices.
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8. Verification Steps

The following steps may be used to verify the configuration:

e Verify that a phone connected to PSTN can successfully place a call to the Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Using a network sniffing tool e.g. Wireshark to monitor the SIP signalling between the
enterprise and Cox. The sniffer traces are captured at the public interface of the Avaya
SBCE.

Following screenshots show an example incoming call from Cox to the enterprise.
e Incoming INVITE request from Cox.

INVITE sip:7036638122@10.10.98.14:5060 SIP/2.0

Via: SIP/2.0/UDP 20.164.94.12:5060;branch=2z9hG4bKtjh6srk9pknu3tthlidvvtep73
From: "BELLEVILLE ON"<si1p:61396752580@20.164.94.12;user=phone>; tag=SDpsgpe01-
704728996-1389972565660-

To: "Test - SIP Trunk Atlanta -
FCPS"<sip:7036638122@coxbusiness.com;user=phone;access-vasb02=ACCESS-VASB02-
e7s8pglp3sb6pe>

Call-ID: SDpsqgpe0l1-677a36b2df28206£f167bbdc37d003dce-vrvviv3

CSeq: 275322703 INVITE

Contact: <sip:20.164.94.12:5060; transport=udp>

Supported: 100rel

Allow: ACK,BYE,CANCEL,INFO, INVITE,OPTIONS, PRACK,REFER,NOTIFY, UPDATE

Accept: multipart/mixed, application/media control+xml,application/sdp
Max-Forwards: 69

Content-Type: application/sdp

Content-Length: 181

v=0

o=BroadWorks 936126212 1 IN IP4 20.164.94.12
S=——

c=IN IP4 20.164.94.12

t=0 0

m=audio 59018 RTP/AVP 0 101

a=rtpmap:101 telephone-event/8000/1
a=fmtp:101 0-15

a=ptime:20
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e Outgoing 2000K response from the enterprise.

SIP/2.0 200 OK

Via: SIP/2.0/UDP 20.164.94.12:5060;branch=z9hG4bKtjh6srk9pknu3tthlidvvtép73
From: "BELLEVILLE ON" <sip:6139675258@20.164.94.12;user=phone>; tag=SDpsgpe0l1-
704728996-1389972565660~-

To: "Test - SIP Trunk Atlanta - FCPS"

<sip:7036638122@coxbusiness.com; user=phone;access-vasb02=ACCESS-VASB02-
e7s8pglp3s6pe>; tag=X57Ed!HXLgEk!uhzT5837944061d8d5¢c

Call-ID: SDpsqgpe0l1-677a36b2df28206£f167bbdc37d003dce-vrvviv3

CSeq: 275322703 INVITE

Contact: <sip:7036638122@10.10.98.14:5060>

Content-Type: application/sdp

Content-Length: 199

v=0

o=UserA 1874781826 346359099 IN IP4 10.10.98.14
s=Session

c=IN IP4 10.10.98.14

t=0 0

m=audio 18424 RTP/AVP 0 101

a=rtpmap:0 PCMU/8000

a=rtpmap:101 telephone-event/8000

a=fmtp:101 0-15

Following screenshots show an example outgoing call from the enterprise to Cox.
e Outgoing INVITE request from the enterprise.

INVITE sip:6139675258@coxbusiness.com:5060 SIP/2.0

Via: SIP/2.0/UDP 10.10.98.14:5060;branch=z9hG4bK2120021837

From: "H323-29225"
<sip:7036638122Q@coxbusiness.com>; tag=X57Ed! HXLgEk!uhzT5411B0825cec060
To: <sip:6139675258@coxbusiness.com>

Call-ID: 708578922@10.10.98.14

CSeqg: 1636 INVITE

Contact: <sip:7036638122;tgrp=tgd4770489482131; trunk-
context=coxbusiness.com@10.10.98.14:5060; transport=udp;user=phone>
Authorization: Digest username="7036638186", realm="BroadWorks",
nonce="BroadWorksXhgjroxafTwlnyeBW", uri="sip:coxbusiness.com",
response="1118623eclcc816e670b85419839ed8e7", algorithm=MD5, cnonce="52d90251f37balf5",
gop=auth, nc=00000001

Max-Forwards: 70

User-Agent: ewb2bua/11.6.14

Content-Type: application/sdp

Content-Length: 247

v=0

o=UserA 2701783037 2924425006 IN IP4 10.10.98.14
s=Session

c=IN IP4 10.10.98.14

t=0 0

m=audio 18452 RTP/AVP 0 18 101
a=rtpmap:0 PCMU/8000

a=rtpmap:18 G729/8000

a=fmtp:18 annexb=no

a=rtpmap:101 telephone-event/8000
a=fmtp:101 0-15
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e Incoming 2000K response from Cox.

SIP/2.0 200 OK

Via: SIP/2.0/UDP 10.10.98.14:5060;branch=z9nG4bK2120021837

From: "H323-29225"

<sip:7036638122@coxbusiness.com>; tag=X57Ed!HXLgEk!uhzT5411B0825cec060
To: <sip:6139675258@coxbusiness.com>; tag=SDhblcb99-1543225330-1389982502944
Call-ID: 708578922@10.10.98.14

CSeqg: 1636 INVITE

Contact: <sip:20.164.94.12:5060; transport=udp>

Allow: ACK,BYE,CANCEL, INFO, INVITE,OPTIONS, PRACK, REFER,NOTIFY, UPDATE
Accept: multipart/mixed,application/media control+xml,application/sdp
Content-Type: application/sdp

Content-Length: 189

v=0

o=BroadWorks 938388615 1 IN IP4 20.164.94.12
g=—

c=IN IP4 20.164.94.12

t=0 0

m=audio 60442 RTP/AVP 0 101

a=rtpmap:0 PCMU/8000

a=rtpmap:101 telephone-event/8000

a=fmtp:101 0-15

9. Conclusion

Cox SIP Trunking passed compliance testing. These Application Notes describe the procedures
required to configure the SIP connection between Avaya IP Office and Cox SIP Trunking service as
shown in Figure 1.

10. Additional References

Product documentation for Avaya products may be found at http://support.avaya.com.
Additional IP Office documentation can be found at
http://marketingtools.avaya.com/knowledgebase/.

[1] IP Office 9.0 Installation, Document number 15-601042 Issue 28, 11 October 2013

[2] IP Office 9.0 Manager 9.0, Document number 15-601011 Issue 9.01, 09 September 2013

[3] IP Office 9.0 Administering Voicemail Pro, Document number 15-601063 Issue 9.0 Release 1.0,
September 2013

[4] IP Office Embedded Voicemail User Guide (IP Office Mode), Document number 15-604067 Issue
9.0, 10 September 2013

Product documentation for Cox SIP Trunking is available from Cox Communications.
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